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EDITORIAL 3

Directeur

Une meilleur
compréhension et
quelques solutions
qui vous permettront
de réaliser le plus
beau rendu !

Vous avez étudié tout les tutoriaux, votre modélisation est parfaite, et vous maitrisez bien les
matériaux, maintenant il est temps de faire le rendu de votre oeuvre d'art. Vous appuyez sur le
gros bouton « Render », puis attendez ce qui semble étre une éternité... et quand le rendu est
enfin fini... heu, pour étre honnéte, le résultat obtenu ne ressemble en rien a ce que vous aviez
imaginé. Que s'est-il passe?

La plupart du temps a priori, I'erreur est minime . Le rendu est le résultat de tout votre travail et de
ces choses en tant que tel. il y a beaucoup de facteurs qui peuvent changer en bien ou en mal
votre image finale. Est ce que votre éclairage est juste, est ce que vos parametres sont corrects,
avez vous pris en compte tout les effets spéciaux que vous avez ajoutés. Méme si tout est juste
rapport a la liste ci-dessus, vous pouvez passer des heures, voir des jours, a attendre que le rendu
se finisse, pour finalement découvrir que vous avez besoin de fignoler un peu quelque chose .

Bienvenue dans le Numéro 3 “Rendering”. Dans ce numéro nous allons parler de certains
problemes qui affectent votre rendu final, apportant Une meilleur compréhension et quelques
solutions qui vous permettront de réaliser le plus beau rendu !

En plus de détailler les techniques qui peuvent améliorer vos rendus, nous allons aussi jeter un
coup d'oeil aux différentes manieres de faire baisser vos temps de rendus, mais nous nous
occuperons aussi des autres moteurs de rendus disponibles pour Blender. De ceux-ci un certain
nombre ont été développés récemment et justifient qu'on leur préte attention.

Nous avons aussi 3 articles articles séparés sur |'utilisation de Yafray, chacun montrant une
technique et une méthode différente.

Bonne lecture !

Sandra
sandra@blenderart.org

www.blenderart.org



Le rendu est souvent un processus
mal compris et a moins d'avoir le «

0

ar bouton faire un beau rendu »;)
f g ¢ intégré, nous devons le faire par un
I8 chemin plus compliqué. Et ca

<

passera par la compréhension ce
qu'il se passe dans un rendu et ce
qui affecte le processus du rendu.

Tout affecte le processus de rendu. Ceci inclut les matériaux,
I'éclairage, les effets spéciaux et la scene elle-méme. Alors que
le rendu pourrait étre le sujet d'un livre entier, nous allons, pour
cet article, nous attarder sur les conseils et les artifices qui
peuvent faire accroitre ou décroitre la qualité ou le temps de
rendu.

Quand on en vient au rendu, certaines choses prennent plus de
temps. Si vous ne devez avoir que cet effet seulement,alors
n'hésitez pas, mais sachez qu'il vous faudra attendre longtemps
avant que votre rendu ne soit complété. Voici une liste des
quelques options qui peuvent faire augmenter vos temps de
rendu: Le Raytracing, un éclairage imitant I'Ambient
Occlusion(AO). L'utilisation intensive des particules.Le rendu de
scenes tres détaillées.

D'autre part, le domaine de l'infographie
regorge de trucs et d'imitations pour réduire
les temps de rendu, comme |'utilisation du
dome [déme] Gl(Global lllumination), qui est
un "fake". Longtemps utilisé dans Blender
avant que I'AO ne soit disponible. Simple a
mettre en place, facile a ajuster et pas ausi
gourmand en ressources que I'AO. En

Cette fois-ci Blentuu nous
emmene au travers des différents jolie. Si vous pouvez tricher ou imiter ces effets,
aspects qui affectent le temps de
rendu. Avec en plus un résumé
avec quelques conseils pour
optimiser vos temps de rendus.

installer un est simple: Add>Mesh>lcosphere, w>subdivide
multi>2. Supprimez la moitié inférieure de la sphére. Ajoutez un
Spot(spotlight) et parentez le a la demi-sphére.Appuyez sur F7,
(Fenétre des options de I'objet). Avec la sphére sélectionnée,
appuyez sur le bouton Dupliverts.

Sélectionnez le Spot et ajustez son intensité vers le bas(environ
0,1).

Changez les autres parameétres selon vos besoins pour obtenir
l'intensité lumineuse et la quantité d'ombres désirée.

Autre chose qui peut faire décroitre [décroitre] vos temps de
rendus: Généralement préférez utiliser des lampes z-buffer sur
d'autres, "raytracées". Faites en sorte que les parameétres
samples et shadow buffer soit le plus bas possible pour la qualité
recherchée.

De méme, baissez autant que possible les samples sur tout ce
que les gens ne remarquerons [remarqueront] pas(lumiéres,
subsurf, raydepth, etc...). Faites des rendus en différentes
passes si possible, vous pouvez recomposer les passes dans
GIMP ou Photoshop, non seulement cela fera baisser vos temps
de rendu, mais vous aurez plus de contréle sur l'interaction entre
chaque couche.

Ne modélisez que les détails qui sont nécessaires, I'UV mapping
et un usage correct des textures peuvent faire baisser le nombre
de polygones. Quand tout cela est dit et fait, n'utilisez seulement
les options et techniques dont avez réellement
besoin pour que votre image ou animation soit

faites-le, cela vous épargnera du temps de
rendu supplémentaire . Si vous devez
absolument utiliser cet effet, alors soyez prét a
attendre. Tout en attendant, je vous suggere de
vous relaxer avec un café et un bon livre.

www.blenderart.org



Actualités Blender

Le plus grand évenement dans le monde
Blenderien est sur le point d'aboutir. Le
projet Orange est bient6t terminé et la
premiére diffusion de "the elephants
dream" a été programmée le 24 mars
2006. Le cinéma Katelhuise d'Amsterdam,
trés connu pour ses documentaires et ses
films faits maison, a été choisi pour cette
avant-premiére.

Le cinéma ouvriraa 17 h 30 et la
projection débutera a 18 h 00, avec un
making of pour conclure cette
scéance.S'ajoutera au visionnement de
"Elephants Dream" des extraits du
"Making of" du film. Si vous ratez la
premiére scéance séance, il y en aura
une autre a 18h45.

Apres la projection, une grande féte sera
organisée dans le nightclub le plus prisé
de la ville, appelé ironiquement "Blender".
Alors que la projection est gratuite, il faut
payer I'entrée pour participer a "I'After". Le

samedi 25 et dimanche 26, I'équipe du
Projet Orange sera a votre disposition au
Montevideo (Keizersgracht 264,
Amsterdam) pour discuter du projet et
participer a d'autres visionnages. Pour
plus d'informations sur I'Avant-premiere et
la présentation vidéo qui suivra visitez le
site http://orange.blender.org/.

Blender est devenu un programme en
constante évolution, avec toujours plus de
fonctionnalités nouvellement écrites et/ou
revisitées pour simplifier et améliorer leur
utilisation. Au cours des deux derniers
mois, I'accent a été mis sur le systéme «
Noodles » (node editor ou encore éditeur
de noeuds...) et le moteur de rendu. Le
systéeme de noeud permet la création de
matériaux et effets de compositing trés
avancés. Le moteur de rendu est en train
d'étre modifié et optimisé pour travailler
plus simplement et efficacement, assurant
ainsi des rendus plus rapides, avec moins
d'erreurs.

Pour essayer une compilation test de ces
nouvelles fonctionnalités, téléchargez-la
depuis le forum des compils test (test
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Actualités S

build forum) sur http://www.blender.org .

Etant donné que ce numéro se focalise
sur le rendu, c'est le moment de découvrir
tous les moteurs de rendu compatible
avec Blender. En plus de YafRay, POV-
Ray, MegaPOV, il existe des scripts
d'export pour les moteurs suivants:

Kerkythea

Site:
http://www.softlab.ece.ntua.gr/~jpanta/Gra
phics/Kerkythea/

Sunflow
Site: http://sunflow.sourceforge.net/

Indigo

Site:
http://homepages.paradise.net.nz/nickamy
/indigo.html

3Delight
Site: http://www.3delight.com/

Metropolight
Site: http://www.3dvirtualight.com/mlt/



ATELIER 3D - rendu professionnel de studio avec HDRI IBL et Gl

Utilisation de Blender en conception industrielle CAD/CAM

Réalisation d'une fourchette
par - Claas Eicke Kuhnen

Introduction

Une bonne image vaut 1000 mots dans
l'industrie du design. Blender est devenu un
outil essentiel dans mon travail parce gqu'il me
permet de visualiser une idée avec une plus
grande flexibilité qu'avec un dessin fait a la
main, et de présenter visuellement mes
concepts et projets de réalisation. Bien que
Blender ne soit pas prévu pour la conception
CAD/CAM et qu'il lui manque de nombreux
outils inclus habituellement dans ces logiciels,
il est tout de méme possible de I'utiliser non
seulement pour le rendu d'un objet mais aussi
pour une grande partie de sa conception.

Partie 1 : La modélisation

Pour un concepteur d'articles comme moi,
avec une orientation actuelle vers le métal
forgé, Blender me procure tous les outils pour
dessiner, tester mes idées et concevoir mes
objets. Les outils de dessins polygonal avec
l'option de sudivision des surfaces me permet
de modéliser toutes les formes que je pourrais
ensuite construire de mes mains. Dans
l'industrie de forge du métal (argent), la
majorité des piéces sont confectionnées a
partir de feuilles, fils et tubes. Les éléments
peuvent étre coudés a la main, forgés sur des
formes et ensuite soudés ensemble. Cela veut

dire que j'ai a traiter principalement des
formes géométriques simples. Et celles-ci sont
vraiment faciles a modéliser avec Blender.
L'adition récente des possibilités de calcul
des angles et longueurs m'a permis de tenir
compte de valeurs exactes. C'est un des plus
grands avantages que peut vous apporter la
modélisation en 3D, car elle vous permet de
travailler avec des dimensions et proportions
correctes. De petites modifications du modéle
ou un changement de point de vue est réalisé
en quelques clics de souris et n'oblige pas a
recommencer tout le dessin comme en
méthode manuelle. (Copie d'écran: : mesures )

Sans compter que Blender vous permet non
seulement de modéliser des éléments

mécaniques mais aussi de les animer, ce qui
m'autorise a tester ma conception et voir les
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problemes qui pourraient se poser.

Des copies d'écran des éléments en affichage
"fil de fer" peuvent étre prises a partir d'une
vue orthographique et composées. Apres
impression sur papier elles peuvent étre
découpées et collées sur des feuilles d'argent
pour servir de guide des formes que je coupe
dans le métal. Travailler avec des calques
permet d'alléger le travail car les éléments
peuvent étre distribués sur des couches
distinctes et affichés couche par couche afin
de créer des copies d'écran claires et utiles.
(Copies d'écran : dessins)

Qutline {top view)

Dutline (front view)



Partie 2 : Application des textures

La version actuelle de Blender et de Yafray
permettent ['utilisation de la plupart des
textures et des modéles d'éclairage
nécessaires a un artiste pour la création de
simulation de matériaux précongus. Mais pour
l'instant, l'utilisation de matériaux comme le
métal brossé ou des matériaux transparents
est impossible, ou seulement en usant
d'astuces et de temps. Pour ma part, je n'ai pu
obtenir les réflections anisotropiques et reflets
spéculaires nécessaires pour simuler
correctement les surfaces de métal brossé
(finement) avec lesquelles je travaille. Mais j'ai
pu obtenir quelque chose d'approchant en
utilisant les textures procédurales avec des
cartes de bruit "noise map" ou des surfaces
"bump map" peintes.

Le probléme est que vous ne pouvez atteindre
un certain degré de réalisme sans voir
apparaitre des surfaces moirées au rendu de
limage. Une surface "bump map" grossiére
permet pourtant d'obtenir suffisemment de
détails pour simuler une surface de métal
brossée. Il faut pour cela étendre la texture le

long d'un axe et garder de bonnes proportions.
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Une faible coloration de la lumiéere et des
réflections permet également de beaucoup
diminuer I'aspect stérile des rendus en lancer
de rayons et me permet de plus d'obtenir une
sensation a laquelle je suis habitué quand
jutilise de vraies lampes de studio. Ces
lampes ne produisent pas une lumiére
blanche. La lumiére est toujours un peu jaune.
Il est également primordial de donner au sol
une couleur différente d'un noir profond. Cette
tonalité de noir sont trés peu éloignées du noir
profond, mais suffisantes pour donner une
apparence réaliste.

Partie 3 : le rendu

Je m'attends a ce que mes rendus finaux
soient le plus réalistes possibles. J'utilise
Yafray comme moteur de rendu principal car il
permet |'utilisation de I'éclairage HDRI,

O E— T S e a——  illumination
e e I BT o BTl Havcoie | | CETECEMN ERE AT globale,
wam | : — I'étalement des
Lamp (i WoimBee 04 o[i Memseghz s ———————
e couleurs (Color
Bleeding), les
) surfaces
ity B .
Dt var CTETer | 1 7 - — caustiques et
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une vraie profondeur de champ.

Ces capacités qui me permettent

d'approcher I'esthétique donnée par des

spots de studio sont essentielles pour
présenter et expliquer mes travaux. J'utilise
pour ma part un fichier HDRi qui ne
contient que 2 sources de lumiere qui
simulent des lumiéres murales diffuses.
Elles produisent des lumiéres extrémement
douces et atténuent les zones de reflets.

La sonde de lumiére apporte la quantité de
lumiere désirée dans la direction adéquate de
la scéne, et dans le méme temps élimine les
réflections indésirables (ou hot spots) sur
I'objet. L'illumination HDRi va non seulement
éclairer la partie frontale de I'objet, mais aussi
émettre suffisemment de lumiére pour éclairer
I'objet métallique de tous les cétés. Cette
méthode élimine le besoin d'utiliser de petites
lumiéres d'appoint pour éclairer des zones
spécifiques comme cela est fait avec le
principe des trois sources de lumiere.




De plus, 'option Gl calcule non seulement la
quantité d'ombre correcte et I'éclairage de tout
I'objet, mais ajoute encore au réalisme en
calculant les "saignements" de couleurs et les
réflections caustiques. Il manque a de nombreux
travaux de rendu ces détails fins absolument
nécessaires. Souvent, ceux-ci ont un impact
significatif sur I'impression de réalisme ressenti
par I'observateur du rendu.

Sélectionner une source d'éclairage HDRi n'est
qu'une des choses que vous pouvez faire. Je
n'utilise dans mon cas que des lumiéres venant
d'une seule direction. Pour des raisons
ethétiques, vous pouvez vouloir atténuer ou
augmenter |'éclairage de certaines zones pour
augmenter la dynamique d'éclairage du rendu.
Les photographes utilisent des réflecteurs pour
modifier I'éclairage de certaines zones. Le méme
principe peut étre utilisé en rendu numérique
avec "Gl".

Les copies d'écran suivantes montrent »' o
clairement la différence. Le "GI" non seulement ' |
calcule la quantité de lumiére venant de la
source HDRI, mais calcule également la lumiére
renvoyée par des réflecteurs et éclaire ainsi des
zones d'ombre sur les cigarettes: de nombreux o
détails sont ajoutés aussi aux réflections sur le X

métal. Comme vous pouvez le voir, j'utilise une

boule chromée pour trouver d'ou vient la lumiére, .
ces informations me permettant de positionner - 7
mes travaux en métal correctement sur la scéne.

Scéne: Vue de dessus

www.blenderart.org

Scene: setup3D

Il est trés important d'utiliser la profondeur de
champ (Depth of Field). Elle permet d'attirer
l'attention du spectateur sur des éléments précis
de mon travail, alors que d'autres éléments sont
noyés dans le flou. Yafray permet d'utiliser une
vraie profondeur de champ qui donnent
d'excélents résultats avec des valeurs
d'échantillons hautes. Le temps de rendu va
évidemment augmenter avec la quantité
d'échantillons, mais le résultat final en vaut la
peine. Le réglage de la profondeur de champ est
accessible a partir de Blender. Une ouverture
(diaphragme de I'objectif) de 0.1 a 0.5 est
suffisante. Pour un rendu progressif de la
profondeur de champ il vous faudra désactiver le
"AA" automatique .

Suivant les scenes, vous aurez a ajuster les
paramétres "AA". J'utilise 15*15 pour les
"Passes AA" et les échantillons "AA".

Page suivante: Réglages des parameétres AA et
réglage de la profondeur de champ.
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Pour le rendu de bijoux, je préfere utiliser un
fond texturé. Un de mes derniers travaux est
présenté sur une surface semi-réflective noire,
avec une texture tres finement granitée. Une
erreur courante en voulant simuler cet effet est
de régler la réflectivité a une valeur trop forte.
Cette réflection de I'objet sur le fond ne doit
étre que trés peu visible, juste pour éviter de
voir "flotter" I'objet. Et au contraire, des
réflections trop dures ne vont que distraire le
spectateur et détourner son attention.

Il'y a deux méthodes pour aboutir a ce résultat.

La méthode "sale", rendu avec Blender :
La réflection peut étre rendue diffuse en
utilisant une carte de bruit dans le canal des
normales. C'est une maniére rapide pour
obtenir des réflections diffuses, méme si elles
ne sont pas correctes physiquement. Dans ce
cas, comme ces réflections ne doivent pas
attirer I'attention, ce n'est pas un grand
probléme.

La méthode propre, avec Yafray:

Yafray supporte le minimum vital question
réflections diffuses. Malheureusement, cette
option n'est pas disponible a partir de
l'interface de Blender: il vous faut éditer
manuellement le fichier XML exporté, et
ensuite lancer le rendu dans Yafray.

www.blenderart.org

Rendu: true_blurred_refl_nobump

De plus, Yafray ne montre pas les réflections
diffuses dans les autres réflections, ce qui
peut étre une limitation dans certains cas.

Pour exporter votre scene dans un fichier
XML, la seule chose a faire est d'autoriser
I'export en XML, de commencer le rendu, et
de stopper Yafray au moment ou celui-ci a fini
de charger la scéne et commence le rendu
(regardez le terminal pendant cette opération).
Quvrez le fichier XML dans n'importe éditeur
de texte, et saisissez les informations
suivantes.



Tout d'abord, insérez le nuanceur "conetrace"
au début de votre document XML aprés le tag
<scene>.

<shader type="conetrace" name="env"
reflect="on" angle="10"
samples="16" >
<attributes>
<color r="0.5"
</attributes>
</shader>

g="0.5" b="0.5" />

Ce paramétre "sample" va définir la finesse de
la réflection diffuse. Des valeurs hautes au-
dessus de 10 donneront le résultat doux
souhaité pour ma scéne.

Mais cela dépend aussi de la distance entre a
caméra et I'objet. En gros plan, des valeurs
plus importantes sont nécessaires.

Quand vous utilisez le nuanceur "conetrace",
vous pouvez désactiver les propriétés de
réflection a partir de Blender.

Ensuite, ajouter un environnement
<environment value="env"/> dans le bloc du
nuanceur des matériaux que vous voulez
rendre réflectifs. Voyez le code dans I'encadré
de droite.

Apres avoir sauvé votre fichier, la seule chose
nécessaire est de laisser Yafray rendre ce
fichier XML. J'ai créé un raccourci pour me
faciliter la vie. Je n'ai qu'a déposer le fichier
XML sur l'icbne de yaffray pour que le
processus se lance automatiquement.

<shader type="blendershader"
name="MAMaterial.002" >

<attributes>
<color r="0.800000" g="0.800000"
b="0.800000" />

<specular color
r="1.000000" g="1.000000" b="1.000000"
/>
<mirror color r="1.000000" g="1.000000"
b="1.000000" />

<diffuse reflect value="0.800000" />
<specular amount value="0.500000" />
<alpha value="1.000000"
/>
<emit value="0.000000" />
<matmodes
value="traceable shadow" />
<diffuse brdf
value="lambert" />
<specular brdf

value="blender cooktorr" />
<hard value="50" />

<environment value="env" />
</attributes>

Malgré tout, cela nous améne 2 problémes:
Tout d'abord I'utilisation d'une carte de bruit va
aboutir & avoir ce motif partout sur le plan de
base. De plus, cette carte de bruits ne me
donne pas l'effet désiré. Voyez le rendu:
fausses réflections bosselées sur la page
précédente.

Deuxiémement, quand vous n'utilisez que des

réflections diffuses avec Yafray, vous obtenez
une surface qui ne montre que la réflection et
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plus sa structure: voyez le rendu: vrai
réflection diffuse a la page précédente.

Pour mon rendu final, je laisse Yafray rendre
les réflections diffuses, mais j'ajoute aussi une
carte "stucci bump" au canal des normales de
mon socle. Nous obtenons alors une tres jolie
réflection diffuse rendue par yaffray, et la
carte "stucci bump" va donner sa structure au
socle. Cela va beaucoup augmenter le temps
de rendu. Si vous avez une carte de
bosselage bien faite pour votre socle, il peut
ne pas étre nécessaire d'utiliser la réflection
diffuse réelle de Yafray pour des matériaux
"stucci bump".

m
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Il vous faudra jouer un peu avec les
paramétres de réflection et les propriétés des
matériaux car chaque changement des
réflections va également influer sur le rendu
des couleurs du socle. Au début, les
réflections et le matériel "stucci map" étaient
réglés trop fort et détournaient I'attention.

Dans le dernier rendu j'ai baissé les valeurs
de réflection, ce qui a eu pour effet de baisser
aussi I'effet de la bump map "stucci”.

Conclusion

Bien qu'il manque a Blender de nombreux
outils de modélisation trouvés sur des logiciels
CAD/CAM, ce projet a montré clairement la
puissance de Blender comme logiciel de
modélisation et conception, avec l'aide de
yafray comme moteur de rendu photoréaliste.
Ces deux logiciels sont assez puissants pour

que les artistes puissent envisager
sérieusement de les utiliser dans un
environnement semi CAD/CAM comme le
mien ainsi que les personnes qui ont besoin
d'un ensemble cohérent d'outils de
modélisation, d'animation et de rendu pour la
visualisation. Comme je réalise toutes mes
formes a la main, je n'ai pas besoin d'un outil
de prototypage rapide (création physique,
fraisage). De plus, des modéles complexes
peuvent étre importés dans Blender pour y
étre texturés et ensuite rendus dans Yafray.

En terme de rendu photoréaliste, Yafray
dépasse certaines réalisations commerciales
a condition de I'utiliser comme il se doit. Cela
peut-étre vu comme la démonstration que les
logiciels Open-Source peuvent rivaliser avec
des solutions commerciales et propriétaires.
Bien qu'il y ait bien s(r certaines richesses

www.blenderart.org

fonctionnelles qui fassent défaut a Blender et
a Yafray pour le moment, il faut noter que ces
deux programmes sont en perpétuelle
évolution.

Blender va adopter un nouveau systeme de
matériaux basé sur les noeuds, et Yafray
continue a améliorer le piqué du réalisme.
Comme artiste, j'espére que les options
actuelles de Yafray (comme les réflections
diffuses) vont étre bient6t intégrées et
accessibles a partir de I'environnement de
Blender. Ces options non seulement
augmentent le potentiel de cette associaition
de logiciels, mais continue & diminuer
I'intervalle entre logiciels libres et
commerciaux.



Modeéle de la véritable fourchette (photographie)
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Claas Eicke Kuhnen (aka F.ip2)

J'utilise Blender pour mon travail général, mais
principalement pour visualiser mes travaux en
argent et tester de nouveaux concepts ainsi
que leurs interactions. )'essaye toujours
d'aboutir a un rendu photoréaliste, et tente de
nouvelles approches et techniques dans ce but.

J'ai travaillé pendant mes études comme
concepteur graphique et multimédia. Nous
avons fondé avec mon frére la société
ConColore? et aportons des solutions de
désign industriel.

www.concolori.de
Fip2@gmx.net
ClaasKuhnen@concolori.de



Utiliser le systeme de rendu Sunflow avec Blender

par Christopher Kulla

Introduction

Dans ce tutorial, je vais vous présenter
quelques fonctionnalités de base de Sunflow
et comment I'utiliser depuis Blender.

Sunflow est mon systéme de rendu open-
source. Il est construit autour d'un petit noyau,
mais tres flexible, qui lui permet d'étre
complétement adaptable. Il contient plusieurs
algorithmes modernes qui en font un bon
candidat pour la génération d'images réalistes.
Il a été récemment connecté a Blender via un
simple script d'export que je vais décrire.

Installation

Sunflow est écrit en Java. Cela signifie que
vous aurez besoin de télécharger et d'installer
le JRE (ou JDK) de Sun si vous ne l'avez pas
déja. Allez sur http://java.sun.com/ et suivez
les instructions pour votre systeme
d'exploitation (les utilisateurs d'OS X auront
besoin d'aller sur le site d'Apple). Sunflow
requiert la version 5 de Java (parfois appelée
1.5) ou supérieure.

Une fois que vous avez effectué l'installation,
allez dans l'invite de commande et tapez : java
-version
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voir une option apparaitre dans le menu File-
>Export comme suit :

& OpenFlight (6.

& PLY..

€ Radiosity (.radio)...
“hO & Raw Triangle {raw...
—'., Save Current Theme...
L -

'., Softimage XS| (=s0)...

Si le bon numéro de version apparait,
tout est installé correctement.

Ensuite, téléchargez la version binaire
depuis le site de Sunflow (v0.05.5 au
moment de la rédaction) et dézippez la
dans le répertoire de votre choix. Allez
dans ce répertoire en ligne de
commande et tapez la ligne de
commande décrite dans le fichier README
inclu dans la distribution. Vous devriez voir
apparaitre la fenétre suivante :

Sunflow Exporter (sc)...
r'., Truespace (.cob)...

Vous étes maintenant prét a rendre votre
premiere image !

Premier rendu : Occlusion ambiante

J'ai préparé une scene trés simple ici dans un
but d'illustration. Libre a vous de suivre avec
votre modeéle favori. Voila a quoi ressemble
ma scene dans la vue 3D :

Enfin, téléchargez le script d'export blender
depuis le site de Sunflow et installez le dans
votre répertoire de scripts (Dans votre
répertoire d'installation de blender). Ensuite
quand vous démarrez Blender vous devriez
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utoriel sur le systéme de ren

Allez dans File->Export et choisissez I'exporter
Sunflow que vous venez d'installer. Cela
donnera l'interface utilisateur suivante dans la
fenétre de script :

LY

Image Fitigr: | T T—

Nous allons juste changer quelques
paramétres dans un premier temps. Notre but
est de faire un simple rendu d'occlusion
ambiante pour voir comment cela fonctionne.
Ne vous inquiétez pas au sujet des nombreux
paramétres différents que vous voyez, nous
allons aborder la plupart d'entre eux bientot.

Dans l'onglet AO Override, cliquez le bouton
'Amb Occ' . C'est une fagon simple de dire au
script d'export que nous voulons traiter toutes
les ombres dans la scene avec le shader
défini d'occlusion ambiante.

La plupart des options sont des nombres
d'échantillonnage (nombre de rayons tracés
pour calculer I'occlusion) et les parametres de
distance (a quelle distance rechercher
d'autres objets).

Pour le moment, laissez le nombre

d'échantillonages comme il est, et mettez la
distance a une valeur raisonnable pour votre
scéne. La valeur par défaut de zéro
correspond a de long rayons infinis.

Maintenant cliquez sur le
bouton "Export" et choisissez
un emplacement pour mettre
le fichier de la scene
exportée. Vous pouvez
regardez la fenétre de sortie
de Blender (la console) pour
voir les différentes étapes de
I'export se dérouler. Cela
prend quelques secondes
pour traverser votre scéne si
vous avez beaucoup d'objets.
Quand le fichier a été exporté vous serez
renvoyé aux options de l'exporter.

Maintenant allez dans la fenétre de Sunflow
que vous avez lancé plus tét et ouvrez le
fichier de la scéne que vous venez juste
d'écrire. Si le chargement réussit sans erreur,
le menu d'options "Render" sera disponible.

Sélectionnez Render-> IPR first. L'image va
commencer a étre rendue sous une forme trés
pixelisée et va progressivement s'affiner.
Apres seulement quelques secondes, vous
pourrez déja voir ce a quoi l'image finale va
ressembler. Vous pouvez annuler le rendu a
tout moment. Dans la plupart des cas, moins
de 10% de l'image est nécéssaire avant que
soyez prét a lancer le rendu en pleine
résolution.
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Maintenant sélectionnez Render -> Render.
L'image va se rendre par petits paquets cette
fois. Si vous avez une machine multi-
processeur vous verrez plusieurs paquets se
rendre a la fois. Aprés quelques secondes
vous pourrez voir quelque chose comme la
scéne ci-dessous :

Félicitations! Vous venez de rendre votre
premiére image avec Sunflow.

Votre image sera probablement trés bruitée et
aura beaucoup de petits artefacts. Ne vous
inquiétez pas. Nous apprendrons comment
améliorer la qualité de I'image bient6t.

Maintenant, rendons notre scéne un peu plus
intéressante en lui ajoutant des lumieres et
des matériaux !



ATELIER 3D - Tutoriel sur le systéme de rendu Sunflow

Lumieéres et Matériaux

Revenez dans Blender et assignez des
matériaux uniques pour chaque surface.
Gardez a l'esprit que I'exporter ne supporte
pas encore l'intégralité des textures et shaders
de Blender.

Pour le moment, nous allons juste créer des
matériaux diffus ordinaires. Pour chaque
matériau, assignez simplement une seule
couleur. C'est le seul attribut qui est lu par
défaut, toutes les autres options sont
ignorées. Il ya quelques exceptions a cette
régle pour générer d'autres shaders Sunflow,
mais nous les aborderons plus tard.

Ensuite, nous avons besoins de lumiéres.
Actuellement I'exporter supporte seulement
les "lamps" et les "square area lights". Les
"area lights" vous donneront de jolies ombres
douces au détriment d'un temp de rendu
additionnel. Ma scene avec des shaders et
des lumiéres basiques ressemble maintenant
a l'image de droite.

Une fois que vous étes satisfait de votre
scéne, il est temps d'exporter a nouveau!
Cette fois, essayons de comprendre les divers
parameétres et comment ils affectent la qualité
de l'image.

Les plus importants sont probablement les
parameétres AA. Les valeurs minimales et
maximales contrélent combien de calculs sont
alloués pour chaque pixel. Les valeurs
négatives signifient que les calculs seront
interpolés a travers plusieurs pixels, les

valeurs positives signifient que plus de calculs
seront faits par pixel. Zéro signifie qu'un seul
calcul est fait par pixel. Par exemple : les
valeurs par défaut de -2 et 0 signifient que le
systeme de rendu devra commencer en
calculant tous les 4émes pixels, et calculer en
fonction de cela jusqu'au niveau de pixel seul
ou c'est nécessaire. Cette fois essayez en
paramétrant vos valeurs de AAa 0 et 2.
Chaque pixel va maintenant étre au moins une
fois et au plus 16 fois (niveau 2).

Si nous calculons plus d'une valeur par
pixel nous aurons besoin de les
moyenner ensemble. La méthode utilisée
pour le faire est contrélé par le paramétre
de filtre image. Choisissons le filtre
"Mitchell" pour que cela donne une jolie
finesse d'image. Ce filtre particulier a une
largeur et une hauteur fixe, donc ces
parametres vont disparaitre de la boite de
dialogue quand il sera sélectionné.

Les paramétres du serveur d'éclairage

vous permettent de contrdler combien de
rayons sont utilisés par lampe. La valeur
par défaut de 16 est un peu élevée mais
donne habituellement une bonne qualité.

L'onglet Gl contr6le l'illumination globale.
C'est un sujet avancé que nous
explorerons dans la prochaine section.
Laissez tous les paramétres a leurs
valeurs par défaut pour le moment.
L'onglet Accelerator contient les
paramétres qui n'ont pas d'impact sur la
qualité de I'image mais qui peuvent faire
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des différences importantes au niveau du
temps de calcul de l'image. L'accélérateur par
défaut est le kdtree et est habituellement le
meilleur choix.

Vous pouvez expérimentez différents types
d'accélérateurs et voir lequel donne les
résultats les plus rapides pour votre scéne.
Vous pouvez aussi ajustez I'ordre des
paquets dans cet onglet. Basculez sur "spiral"
cette fois pour avoir une image calculée
depuis le centre.

Area lamp—




Sous l'onglet "light", nous avons l'option
d'ajustement de la force de toutes les lumieres
dans la scene. Comme Sunflow utilise plus de
calculs basés sur la physique que Blender, les
puissances des lumiéres ne correspondent
habituellement pas. Le facteur d'échelle global
peut vous aider a compenser cela. J'ai mis le
mien & 5, mais cela variera d'une scéne a une
autre. Notez que le facteur d'échelle affecte
seulement les "area lights".

Finalement, rappelez-vous de désélectionner
le bouton "Amb Occ" de I'onglet "AO Override"
s'il était toujours sélectionné depuis le
précédent export.

Nous pouvons maintenant exporter et calculer
le rendu une nouvelle fois. Si vous exporter a

la méme place qu'avant (en écrasant le fichier
précédent), vous pouvez simplement utiliser

I'option du menu File -> Re-open dans le GUI
de Sunflow pour recharger rapidement votre
scene.

Utilisez la fonction d'IPR une nouvelle fois
pour voir a quoi ressemble rapidement votre
scéne. Vous aurez probablement besoin de
quelques cycles d'export avant d'obtenir les
intensités de lumiéres correctes. Voici mon
résultat (Image en bas a gauche).

En dépit des ombres douces, cette image
n'est pas encore tres réaliste. Je vais vous
montrer comment y arriver dans la prochaine
section.

Techniques d'illumination globale
Comme je I'ai mentionné dans l'introduction,
Sunflow est un moteur de rendu trés
adaptable. C'est ce qui permet d'incorporer
différents algorithmes de Gl dans une
structure cohérente. Cela donne aux
artistes différentes facons d'arriver a
leurs buts et cela permet au
développeurs d'introduire de nouveaux
algorithmes, sans ruiner les vieilles
scenes.

Je vais maintenant décrire briévement
l'une de ces méthodes de calcul de
lllumination globale : le "path tracing”.
C'est la méthode la plus précise et la
plus facile a apprendre. Le piege est
que cela peut étre un peu long pour
obtenir des résultats de grande qualité.
Dans I'exporter, allez dans I'onglet Gl et
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activez le button "path". L'algorithme est
contrblé par deux parametres : "samples" et
"bounces". Le premier est par défaut a 32 et
contréle la qualité du résultat. Le second est
par défaut & 10 et contréle combien de
rebonds la lumiére est autorisée a faire.

Laissez les valeurs par défaut pour le moment
pour voir leur effet. Comme cet algorithme va
produire des résultats tres bruités, allez dans
I'onglet AA et mettez les valeurs de min et de
max a 0. Cela va forcer seulement a prendre
un échantillonage par pixel, ce qui va forcer
I'anti-aliasing a super échantillonner tous les
pixels seuls a cause du bruit.

Vous voudrez peut-étre remettre le flitre "box"
(largeur et hauteur 1) pour éviter l'introduction
d'artefacts en filtrant le bruit.

Exportez et calculez le rendu encore une fois.
J'ai ajouté des murs derriere ma scéne pour
voir I'effet des rebonds. Comparez ces deux
rendus avec et sans illumination globale :

Qu'est ce que I'illumination globale

L'illumination globale (Gl) fait référence
aux méthodes qui sont basées sur un
calcul physique de la lumiére dans une
scéne en prenant en compte les effets de
rebonds de la lumiére sur et depuis les
surfaces 3d. Cela produit les simulations
d'éclairage les plus réalistes en image de
synthese.
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quantité de temps raisonnable, lorque vous aviez utilisées avant (le script d'export
mettrez le nombre d'échantillonnages un peu respecte les calques de Blender), et assurez
haut. C'est une limitation théorique de vous que votre scene soit "open”. Ce type
l'algorithme de "path tracing”. Le "photon d'éclairage suppose que la lumiére vient d'une
maps" (lancer de photons) et I"irradiance distance infinie, donc c'est le plus adapté pour
caching" (tampon d'irradiance) sont deux les rendus d'extérieurs. Les sceénes d'intérieur
algorithmes qui quand ils sont combinés seront trés médiocres avec cette technique.
peuvent produire une solution beaucoup plus
efficace; cependant ils sont beaucoup plus Sunflow approxime la carte d'environnement
compliqués a paramétrer, méme pour les avec un nombre fixe de lumiéres
utilisateurs expérimentés. directionnelles. Cela est controlé par le
parametre "Direct samples" dans I'exporter.
Plut6t que d'aller dans les détails de ces En utilisant la valeur par défaut de 16 vous
méthodes avancées, il vaut peut étre mieux verrez probablement quelques bords
Scene avec Gl savoir que des algorithmes plus simple et plus  anguleux pour les ombres issues des lumiéres
Scene sans Gl efficace existent et qu'ils apparaitront trés individuelles utilisées. Augmentez simplement
vraisemblablement bientét dans Sunflow. le nombre d'échantillonnage de I'éclairage
. jusqu'a ce que les ombres anguleuses
Eclairage a partir d'image diminuent a un niveau acceptable.
Dans cette section nous aborderons
l'utilisation de carte d'environnement HDRI Exportez et calculez le rendu une nouvelle
pour l'éclairage. Revenez dans votre scéne fois, vous devriez aboutir a quelque chose
blender, chargez une carte d'environnement comme cela :

HDRI longitude-latitude comme une texture au
niveau "world". Assurez-vous de décocher
"relative paths" quand vous chargez la carte.
Renommez ['objet texture en "ibllight" comme
montré. Cela permet a I'exporter de savoir si
vous voulez traitez cette image comme une
source de lumiere d'environnement.

Remarquez comment les régions ombragées Continuez et cachez toutes les lumiéres que
ne sont plus totalement :

noires et comment nous -
obtenons de subtils E
débordements de couleur Lem
sur le sol et entre les objets. | |- -

Vous pourrez trouver

difficile de réduire le bruit
dans l'image dans une

Dt s
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Cette image est assez réaliste, bien que nous
n'ayons utilisé aucune illumination globale.
Bien s(r, vous pouvez activez "path tracing"
comme nous l'avions fait avant pour simuler
les rebonds supplémentaires de lumiére.

Les matériaux brillants
Finalement, rendons nos shaders un peu plus
intéressant. Jusqu'a maintenant nous avons

utilisé des shaders complétement diffus.

Commengons avec le shader
réfléchissant. Cela ajoute simplement
une fine couche de réflection par dessus
la couleur diffuse. Renommez un de vos
matériaux pour que nom commence
avec "sfshiny". L'exporter va maintenant
lire I'attribut "RayMirr?" pour déterminer
la quantité de réflection a appliquer.

Ensuite vient le shader phong qui permet
des réflections douces. Renommez le
matériau que vous souhaitez éditer pour
qu'il commence par "sfphong". La
couleur de spéculaire contréle maintenant la
quantité de reflection et la valeur "hard"
contrdle la dureté. Les plus grandes valeurs
de dureté donne les rélections les plus
précises. Pour ma sceéne j'ai utilisé des
valeurs comprises entre 5 et 50.

Maintenant que nous avons ajouté plusieurs
calques de réflections, nous avons besoin de

porter attention au parametre de "Max Depth"
dans la fenétre de dialogue de I'exporteur.
Cela contréle combien de niveaux de
réflections sont autorisés. La valeur par défaut
de 9 est plutdt élevée donc nous la réduirons
a 3 cette fois.

Voici le résultat final, rendu avec I'éclairage a
partir d'image de la section précédente :

p

Conclusion

J'espere que vous avez apprécié ce rapide
tour des fonctionnalités du systéme de rendu
de Sunflow.

Un tutorial n'est pas suffisant pour couvrir tout
ce qui est possible avec ce logiciel. Beaucoup
plus de choses sont supportées, comme les
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textures, les réfractions, la profondeur de
champ, les caustiques,et méme le "procedural
shading" S'il vous plait visitez la page officielle
de Sunflow (http://sunflow.sourceforge.net) et
les forums Elysiun (http://www.elysiun.com/)
pour en apprendre plus. Joyeux rendu | m

Christopher Kulla

Christopher Kulla est le
développeur principal du systeme
de rendu Sunflow. Dans sa vie
professionnelle, il travaille comme
développeur de logiciels pour Reel
FX Creative Studios a Dallas, au
Texas, travaillant sur des publicités,
des films DVD et des projets de
long métrages d'animation.

http://sunflow.sourceforge.net



Gl et lumiére HDRI dans Yafray

par Zsolt Stephan

Introduction
Il'y a une multitude de chemins pour éclairer

une scene, de quelques spots tous simples, en

passant par les lumiéres "area" et les
groupements complexes de lumiéres jusqu'a
différentes formes d'illumination globale. Je
vais parler de cette derniére option en utilisant
Yafray pour les rendus depuis l'interface de
Blender. Premiérement [je veux m'adresser a
tous ceux qui croient que la Gl est comme le

bouton magique "faire un rendu réaliste"]. C'est

simplement un modele d'illumination qui est
plus avancé que les bons vieux spots, et plus
précis physiqguement. Ca ne vas pas réaliser
automatiquement une belle images pour vous,
¢a vous donnera simplement un point de
départ pour éviter de faire un grément trés
complexe avec des douzaines de lampes que
vous auriez dd placer a la main. Ga vous fait
gagner du temp (et le temp, c'est de l'argent).

Ca donne une base lumineuse, avec un
distribution uniforme de la lumiére, et un look
naturel. Ca peux (et doit étre) complété avec
des lampes traditionnelles.

A part I'éclairage, I'algoritme de rendu
d'lllumination Globale est responsable du
mélange des couleurs entre les objets (dur a
simuler sans la Gl), et des caustiques (quasi
impossible a simuler). Cependant, la Gl est
plus lente que le raytracing et beaucoup plus
lent que le rendu "scanline", et c'est donc
seulement pour le rendu final. Ca n'est pas
vraiment utilisable pour les animations (bien
sur), pas seulement a cause du temps de
rendu, mais parce que les points
clairs/sombres sont rendus aléatoirement
(échantillonnés) et ils passent d'une position a
l'autre a chaque image.

Premierement nous allons regarder les
réglages de la Gl
de Yafray, et
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ensuite je décrirai une configuration typique de
I'éclairage que j'utilise pour des visualisations
de produits.

L'illumination globale est différente du
raytracing. Dans ce dernier un rayon est lancé
de la caméra a I'objet, il peut étre
refleté/refracté, et ensuite tracé vers toute les
lampes visibles. Ga vous donne de la
reflection, de la réfraction et des ombres
(dures). La G, d'un autre c6té trace le chemin
des photons eux-mémes depuis les lampes
jusqu'aux objets, en rebondissant entre les
objets de la scéne. Ga vous donne de la
reflection, de la refraction ET le mélange des
couleur, des ombres douces, des caustiques
(impossible avec le raytracing) et
généralement un look plus sympa. L'origine de
la lumiére dans la Gl peut-étre une lampe ou
tout autre objet. Pour les scénes d'extérieur, la
toile de fond entiére (world) peut émettre de la
lumiére. Puisque Blender ne supporte pas
encore la Gl, j'utilise Yafray.

Les panneaux étendus de Yafray dans les options de rendu [F10] de Blender.

‘ BEMDER Shadow ErvMap [I‘ |Fu|| E I 4  Depth:2 » I
| vaff * | Auto A4 || Clarnp RGB | Ty
ey " T e [RETTN] oo
[ MBLUR T [« AAPasses2  »|[« AMSamplesd4 |
5 E T ! 16 Ilef:u.scr 75% IOl 25% | |Psz1s00 wess) —|[mrooso | | [+ shedouwosoo | [+ count: 100000 - |
It Mparts:1 » |« Vparts:1 » || Feids | Odd | X [ Faydeoths  +][<  Processorsii | | ‘Preci10)][Ref:0.100 | [Padius:1 00! ]
: : e Bl | [MO00L ] [«  EmitPwr:100 | |+ MixCount:100 » |
) Fremu [ Key (128 =] Border [Gam 1.000 ! | [Exp 0.000 | | [£__GiPwrioso || TunePhotons |
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Réglages Gl

D'abord, assurez vous que vous avez installé
Yafray, et que cet emplacement soit ajouté a
la variable d'environnement 'Path' de votre
systéme (voir le "lisez-moi" de Yafray). Dans
Blender, allez aux boutons de rendu, et dans
la liste déroulante en-dessous du gros bouton
RENDU, selectionnez Yafray. Ca devrait
ouvrir deux panneaux de réglages
suplémentaires : "Yafray" et "Yafray GI". Dans
le panneau Yafray, le bouton XML devrait étre
désenclenché, ce qui vous permet de voir le
progrés du rendu.

Les deux boutons au-dessous vous
permettent de spécifier les paramétres de
l'anti-aliasing. Les autres boutons du bas ne
sont important pour l'instant, ce n'est pas la
peine de les toucher. L'autre panneau, "Yafray
GI", est plus important. La liste "Method" vous
permet de sélectionner "None" pour aucune
Gl, "Skydome" pour un une méthode similaire
a I'AmbianteOcclusion? de Blender et "Full"
pour la vrai Gl. Sélectionner "Full" affiche de
nouveaux boutons en bas.

La qualité du paramétrage détermine (devinez
quoi ! ) aussi bien la qualité que la rapidité du
rendu, un réglage a medium/high devrait étre
suffisant pour la plupart des situations. S'ily a
des petites faces, des détails modélisés, ou
des surfaces trés proches les unes des autres,
vous devrez mettre une meilleur qualité pour
vous débarrasser des artéfacts de rendu.

Une solution de Gl compléte peut
douloureusement longue a rendre(des

heures), donc quelques astuces sont utiles
pour accélerer le processus. Activez le Cache
et les Photons dans le panneau "Yafray Gl".
Le cache des photons accélérera le rendu par
dix | Cependant, ca fera apparaitre des points
clairs/sombres sur le rendu final. Augmentez
la Qualité pour vous en débarrassez, ou
changez le bouton "Ref". Si vous changez le
bouton "Ref" (réaffinage) pour mettre autre
chose que 1 (j'utilise 0,1), ¢ca calculera la carte
des photons deux fois avant le rendu final. La
seconde passe effectue plus de calculs dans
les régions plus détaillées de I'image, et le
résultat final n'en sera que meilleur.

Les autres réglages importants sont :
"EmitPwr?" et "Gl Pwr". La puissance
d'émission détermine la luminosité des objets
emetteurs, des lampes "area" et
du fond. La puissance de la Gi
détermine combien d'energie
(lumiére) ces émetteurs
émettrons. En général il suffit
de changer la puissance de la
Gl pour rendre votre scéne plus
sombre ou plus claire.

Emetteurs

Pour utiliser la Gl, vous devez
avoir des émetteurs de lumiere
dans votre scéne. Ces
émetteurs dans Blender/Yafray
peuvent étre les suivants : "area
light", des objets avec une
émition a plus de 0, et le fond.
Le plus simple a faire est de
regler la couleur du fond avec

www.blenderart.org
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autre chose que du noir. Le fond émettra
uniformément dans toutes les directions,
comme un jour nuageux. Vous pouvez aussi
charger une "HDR light probe", laquelle
determine quelle lumiére colorée vient de
quelle direction.

Maintenant, essayons quelques éclairages !
J'utilise une scene que jai faite il n'y a pas si
longtemps, c'est un concept pour un support
pliant a vin. Vous pouvez voir I'image finale
ici, c'est pour la visualisation du produit. Donc
la part la plus importante de l'image est le
produit lui-méme, et rien ne doit étre présent
pour attier I'attention de I'observateur ailleurs,
pas méme une scene d'arriere plan.

Visualisation du produit |- "Espace Blanc"




ATELIER 3D - Gl and lumiére HDRI dans Yafray

C'est un de mes réglages favoris, a défault de
mieux je l'appele "espace blanc", le produit est
sur un sol completement blanc, avec un fond
blanc, cependant il ne flotte pas dans
l'espace, il possede des ombres. Ca donne
trés bien sur des impressions papier,
aussi bien que sur d'autre document
ou d'autre fond blanc (une web page
par exemple), en donnant I'impression
que I'objet est lui-méme sur le papier.

Si vous regardez de prés, vous
pouvez voir deux types d'ombre ici.
L'ombre dure vient de la lampe "sun",
mais vous pouvez utilisez d'autre type de
lampe qui projettent des ombres. NOTE : a
part les "area lights" ! Les lumieres "Area"
agissent comme des émetteurs de photons
lors de rendu avec de la Gl dans Yafray, et
non pas comme une lampe normale ! Les
belles ombres douces sont le résultat de la Gl.
La scéne

= Camera

La scéne est composé, en plus du produit,
d'un plan blanc et d'une lampe "sun", rien de
plus, c'est trés simple.

Le sol

Le plan blanc ne doit pas étre trop grand, juste
assez pour recevoir toutes les ombres de
l'objet. Il est complétement blanc et la
Reflexion est de 1,0. Notez que l'option "Only
shadow" ne fonctionne pas avec Yafray. Ca
peut rendre les bords du plan visibles dans le
rendu final, ce qui n'est pas bon ! On peut
régler ¢ca dans les paramétres de rendu, voir ci-
dessous.

La lampe
Il n'y a qu'une seul lampe dans la scéne, une
lampe "sun" avec les ombres "Raytraced"
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activées. Mettez une couleur trés Iégérement
jaune avec une puissance de 0,6.

Le monde

¥ YWorld

Encore trés simple, le monde est d'une
couleur, un blanc trés Iégérement bleuté.

Configuration du rendu

¥ YalRay Gl

hadiow and Photona
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IMPORTANT ! C'est vraiment foireux et j'en ai
souvent vus de mauvais exemples, quand un
produit est montré sur un plan gris flottant dans
I'espace, ou du moins sur une sorte d'arriére
plan. Ce plan crie Iimage de synthése. Il est
tés important que vous ne voyiez pas ce plan
de base, il doit étre fondu dans le décor. Dans
cet exemple j'utilise un plan blanc, mais parfois
un plan blanc peut-étre Iégérement grisé aux
bords. Le fond lui-méme est Iégérement bleu et
non blanc. Donc I'astuce pour avoir un effet
"Espace Blanc" est de mettre 'EmitPwr de
Yafray a plus de 1.

Il faut faire quelques tests pour trouver les
bons réglages afin de ne pas voir les bords du
plan de base, mais il ne brille pas d'une
maniére non naturelle non plus. Un réglage de
1.20 semble bien marcher. La puissance de la
Gl est 2 0.80. Si vous réglez la lampe du soleil
plus brillante, alors diminuez un peu ces
valeurs. Au contraire augmentez les si votre
scene est plus sombre.

Faites quelques rendus de test a faible
résolution. Cliquez et maintenez the bouton
gauche de la souris sur le rendu, ce qui
révelera la couleur du pixel donnée en bas a
gauche. Bougez la souris alentours et vérifiez
que tout 'arriere plan ainsi que le plan de base
est blanc (R: 255, G: 255, B: 255). Maintenant
vous étes prét pour le rendu final en haute
résolution ! Vérifiez que vous avez réglé en
qualité Moyenne ou Haute, la valeur Ref
différente de 1, et activez I'antialiasing. Dans
cet exemple j'ai utilisé deux passes avec 4
samples chacune. C'est le réglage que j'ai
I'habitude d'utiliser car c'est un bon compromis
entre qualité et vitesse de rendu. Et regardez

quelle qualité nous avons atteint avec des
réglages si simples !

Visualisation d'un produit Il - Eclairage HDR
A la place d'un monde blanchétre ; vous
pouvez utiliser une light probe HDRI pour
I'arriere plan. Ceci fera varier la couleur de la
lumiere ainsi que son intensité au travers du
ciel virtuel, lui donnant un aspect plus doux et

plus naturel. Pour clarifier les deux termes,
HDR signifie image a fort contraste dynamique,
ou a la place des valeurs RGB allant de 0 &
255, nous avons des valeurs a virgule flottante
apportant plus de précision, et un "contraste
dynamique" potentiellement plus élevé utilisé
pour stocker les valeurs de luminosité
(émission de lumiére) de chaque pixel.

Light probe signifie que I'image est un
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panoramique complet de I'environnement a
360°. Le procédé utilisé pour créer des light
probes HDR est en dehors du contexte de ce
tutoriel, alors je vais simplement vous dire de
télécharger I'une des nombreuses HDR probes
disponibles sur le net (sur
http://www.debevec.org par exemple), ou
encore de créer la votre. Soyez bien sir que
c'est au format d'une light probe (cad. en
image angulaire), par opposition a : croix
verticale, latitude/longitude, ou autre format
panoramique.

L'étape suivante peut étre sautée, mais je la
recommande vivement. Le probleme de
lllumination globale avec Yafray est que pour
un rendu rapide, il utilise des échantillons
aléatoires de I'environnement. Une image
HDRI belle et précise peut avoir des valeurs de
lumiere différentes dans un interval trés court,
par exemple : trop de contraste.

Avec seulement quelques échantillons,
certains tomberont sur un pixel trés lumineux
et d'autres sur un pixel voisin plus sombre et
cela résultera en un rendu "granuleux". J'ai
résolu ce probléme en ajoutant du flou sur
I''mage HDRI originale. Vous pouvez
télécharger la version 1.0 de HDRShop
gratuitement depuis http://www.hdrshop.org.
Quvrez la probe avec et depuis le menu
"Filtres", sélectionnez "Flou Gaussien" et
appliguez-le a I'image avec une valeur de 4-5
pour des petites images : 512x512, jusqu'a 12-
15 pour des images de plus haute résolution
comme 1512x1512. Sauvez I'image sous un
autre nom.



Charger la sonde HDRI

Cliquez sur le bouton des textures et
sélectionnez le bouton vert "World". Réglez le
type de texture sur "image" et chargez le fichier
*.hdr comme n'importe quelle autre image. Allez
dans le panneau "world" et choisissez I'onglet
"map to". Réglez le mappage sur "Angular map"
et dans I'onglet "Output”, enclenchez les boutons
"Hori", "ZenUp" et "ZenDown". Yafray va
automatiquement détecter que vous avez une
image HDRI en texture du monde, et quand
lllumination globale (Gl) est enclenchée, il
utilisera automatiquement cette image pour
I'éclairage.

Zenlg
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extendad backdrop plana

lampe "Sun" utilisée pour les ombres
dures additionnelles pouvait étre placée
n'importe ou. Cependant, la plupart des
probes HDRI possédent une ou plusieurs
sources de lumiéres concentrées. En
premier lieu, faites un rendu de la scéne
avec uniquement l'illumination globale
(Gl) sans lumieres. Observez de quelle
maniéeres les ombres douces sont
projetées et positionnez la lampe "Sun"
en fonction. Vous aurez peut-étre besoin
de faire plusieurs tests de rendu pour
obtenir la bonne orientation des ombres
dures. J'utilise habituellement des lumieres trés
subtiles et faibles avec des images HDRI,
I'énergie devrait étre autour de 0.2-0.4,
pas plus.

apportent aussi un environnement réaliste que
les objets peuvent refléter. Elle peuvent aussi
servir d'arriere-plan, cependant la plupart des
probes HDRI sont trop basses en résolution pour
fournir une jolie image de fond. A la place, il est

Zenbao

Mise en place de la scéne

Semblable a I'exemple précédent. Le plan de
base n'est cependant pas suffisant car vous
verrez ses bords dans le rendu. Pour remédier a
ceci, courbez le bord du plan le plus éloigné vers
le haut, suffisament haut pour couvrir tout le
champ de vision de la caméra. Vérifiez bien que
la courbe commence plus loin que les ombre de
I'objet, autrement vous verrez I'ombre se courber
d'une maniére non naturelle dans les airs.
Regardez I'image en haut a droite.

Les lumiéres

La méthode de "I'environnement blanc" décrite
plus haut avait une lumiere blanche
completement uniforme, ce qui veut dire que la

préférable d'utiliser une photo de I'endroit original
pour le fond. Cette image test montre une de
mes propres probes en action, en association
avec une photo de fond prise au méme endroit.
Remarquez qu'a la place d'un plan qui crie
"image de synthese", j'ai utilisé un pied d'estal en
pierre qui se fond mieux dans l'image.

Parameétres de rendu

lls devraient étre similaires a la premiere
méthode, exception faite des parametres
de la puissance de l'illumination globale.
Ceci peu varier grandement selon l'image
HDRI que vous utilisez, dépendant de sa
luminosité. Faites quelques rendus rapides en
basse résolution pour trouver la bonne
luminosité. Les images plus sombres auront
besoin de 1-1.5 au plus, alors que les images
les plus lumineuse n'auront peut-ére besoin

que d'une puissance de 0.2. Et maintenant

vient le rendu final ! Voici ma scéne de test
avec une image HDRI de couché de soleil faite
sous Terragen. La méme qualité sans
lllumination globale nécéssiterait une douzaine
de lampes, toutes paramétrées correctement,
nous voyons donc clairement les avantages.

Non seulement les images HDRI fournissent
I'éclairage de base d'une scene, mais elles
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C'était juste une petite partie de ce que vous pouvez faire
avec l'illumination globale, vous pouvez aussi I'utiliser pour
les scenes d'interieur. Essayez de placer des plans
émetteurs ou des "area lamps" dans votre scéne. Pour les
caustiques, ajouttez des lampes de type "photon” qui sont
disponibles dans le panneau de paramétres des lampes
dans Blender. m

Faites des experiences. Amusez-vous !

Zsolt Stephan

J'habite en Hongrie et j'étudie en ce moment le
design industriel a l'université de technologie et
d'économie de Budapest.

Quelques unes de mes passions sont : la 3D bien
s(r :), design de conception/production, regardez
des bons films, sortir avec des amis, écumer les
forums d'Elysiun et d'autres, dessiner.

http://yafray.org
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ATELIER 3D - 1utoriel pour I'échantillonneur de caustiques de Yafray

Utiliser le systeme de caustiques de Yafray depuis Blender

par Daniel LaBarge

Dans ce tutoriel nous allons faire des
expériences avec Yafray et Blender et
apprendre comment ils interagissent entre
eux. Nous allons créer un effet de caustique
simple en utilisant les paramétres par défaut.
Des expériences plus poussées pourrons étre
utilisées pour créer des images a couper le
souffle !

www.blender.org et www.yafray.org. Une fois
installées, vous serez prét a commencer le
rendu de votre premiére scéne avec
caustiques.

Utiliser les caustiques

La mise en place de la scéne est trés simple.
Nous utiliserons la scéne par défaut avec
quelgques changements dans le placement des
lumiéres.

Etape 1. Lancez Blender

Etape 2. Allez dans le panneau de rendu
(F10) et changez le moteur de rendu de
"Blender Internal” a "Yafray Renderer".

Ceci va créer de nouveaux panneaux dans les
boutons de Rendu, Edition, Materiaux et
Lampes. Nous verrons ces nouveaux
panneaux sous peu.

Etape 3. Dans la fenétre 3D, sélectionnez
(boutton droit de la souris) le cube par défaut.
Allez dans le panneau des Materiaux (F5). Le
panneau de Raytracing introduit les options

Pour commencer

En premier lieu, nous

aurrons besoin des

derniéres versions de
Blender (2.41) et de Yafray

(0.7) toutes deux installées
sur votre ordinateur. Vous
pouvez les obtenir
respectivement depuis
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Yafray disponibles. Nous allons faire un verre
clair en utilisant les réglages par défaut pour
le verre dans ce panneau. Sélectionnez 'Clear
Glass' dans le menu déroulant. Réglez le
reste des parametre de votre materiel selon la
Fig. 1. Vous pourriez avoir envie de bisauter
les arretes du mesh. Pour cet objet j'ai utilisé
'Subdivide Multi' trois fois puis ajouté un
'‘Bevel' de 0.100 deux fois et enfin appliqué un
'Set Smooth'. Un bisautage basique devrait
fonctionner aussi. Regardez I'image en-bas.

Etape 4. Dans la fenétre 3D, passez en vue
de dessus (Num 7) et ajoutez (barre
d'espace) un plan (Add>>Mesh>>Plane) a la
scéne, ceci sera le sol de notre scéne. Sortez
du mode d'édition (Tab). Vous devrez le
bouger (G) vers le bas le long de I'axe Z (2)
d'une unité de grille (maintenez CTRL
enfoncé) de facon a ce qu'il soit au niveau du
bas du cube. Ouvrez le panneau des
propriétés de transformations (touche N) et
augmentez l'echelle uniformément a 50 unités
ou appuyez simplement sur 'S' et augmentez
la taille de maniére a remplir le champ de la
caméra. Allez dans le panneau des materiaux
(F5) et ajoutez un nouveau materiel.

www.blenderart.org
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Vérifiez que vous avez bien l'option
"TraceShadow' enclenchée dans ce materiel.
Vous pouvez méme appliquer une texture si
vous le voulez. J'ai utilisé une couleur
légérement bleutée pour ce materiel.

Etape 5. Dans la vue 3D, passez en vue de
dessus (Num 7), sélectionnez la lampe par
défaut et supprimez-la. Maintenant placez
votre curseur a approximativement 0;4;2 XYZ
de coordonnées globales. Appuyez sur la
barre d'espace et ajoutez une lampe
d'environnement Add>>Lamp>>Area. La
lampe devrait étre sélectionnée
automatiquement, dans le cas contraire,
sélectionnez-la et faites apparaitre le panneau

de transformations (N). Réglez la position XYZ
respectivement sur 0;4;2 dans le panneau de
transformations. Réglez les coordonnées de
rotation XYZ respectivement sur 65;0;180.
Dans le panneau Material/Lamp réglez
I'énergie sur 0.250. Donnez-lui la forme d'un
carré de 3.0. Réglez 'Shadow Sample' sur 10
ou plus.

Etape 6. Dupliquez (MAj+D) la lampe 'Area’ et
annulez (RMB) la fonction automatique de
déplacement. Ceci placera la lampe dupliquée
a I'emplacement exact de I'original. Dans le
panneau Material/Lamp changez le type de
lampe pour 'Photon’. Dans Blender, la seule
maniére de générer des caustiques dans la
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scene est d'utiliser cette lampe. Changez les
réglage des 'Photon' comme sur la Fig. 2.

Etape 7. Maintenant passez dans le panneau
de Rendu (F10) et changez les paramétres
selon la Fig. 3.

Etape 8. Faite un rendu de la scéne (F12) !
Votre résultat devrait étre similaire a celui de
la premiere image de la page précédente. Au
cas ou votre rendu est différent, essayez de
faire correspondre vos réglages au plus
proche de ce qu'il vous a été donné plus t6t
dans les figures d'illustration. Vous pouvez
aussi jeter un coup d'oeil au fichier d'exemple
caustic.blend si vous n'y arrivez pas.

¥ afray: Shadow ard Photons

¥ Rendcler

Shadow  Envidap

RENDER
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Qu'est-il arrivé ?

Maintenant que nous avons créé un bon
exemple de caustiques, nous allons observer
la maniere dont les caustiques ont fonctionnés
dans cette scéne et quelles autres options
sont disponibles dans l'interface de Blender. ||
y a trois panneaux dans l'interface de Blender
qui contiennent des parameétres pour les
caustiques.

Le premier est le panneau de Yafray lui-
méme. Ce panneau vous permet de contrbler
les options du moteur de rendu Yafray.
Normalement il est bon de simplement
désactiver XML de sorte a ce que vous voyiez
le rendu en temps réel. Vous pouvez aussi
laisser le Auto-AA activé pour laisser Yafray
contrdler automatiquement l'option d'anti-
aliasing. Pour un contréle plus en détail des
caustiques vous devrez par contre passer en
mode manuel pour ces parametres.

Le second panneau est le panneau Gl de
Yafray. Gl signifie lllumination Globale.
L'illumination globale est I'effet produit par
I'émission de la lumiére depuis une source
globale. Pour cet essai nous avons utilisé le
type 'Full GI' et réglé la qualité sur 'High' pour
de meilleurs résultats. Les autres parametres
sont Depth et CDepth. Depth est la distance
calculée par Yafray pour un rayon durant le
lancer de rayon (raytracing). Plus la valeur
sera basse, plus le raytracing sera rapide mais
moins précis. CDepth est similaire sauf que
c'est pour les photons caustiques dans la
scéne. A nouveau, plus la valeur sera petite,
plus les caustiques seront rapide mais moins

précis dans la scéne. Nous avons également
activé 'Photon’ dans ce panneau. Cela
activera Gl Photons qui sont aussi appelés
Helper Photons. lls sont alors émis depuis
toutes les lumiéres présentes dans la scéne.
Plus nous utiliserons de photons (100 000)
meilleur sera le résultat, mais ceci augmentera
aussi le temps de rendu d'une maniere
exponentielle.

Le dernier panneau est le panneau des
Lampes (F5). Il est situé dans les boutons de
Material/Lamp. Vous devrez sélectionner la
lampe 'Photon’ dans la scéne pour voir I'onglet
'Yafray Shadow and Photon'. En activant la
lampe 'Photon’ nous avons activé I'utilisation
des photons pour les caustiques depuis une
source directe. Ici, le réglage de la puissance
est comme n'importe quel autre et dit combien
les caustiques seront brillants. Cette lampe
'Photon’ nous permet de donner la direction
des caustiques et ainsi d'optimiser le résultat
des caustiques d'une belle maniere. Nous
avons utilisé environ 100 000 photons ici. Pour
des scenes plus complexes cela peut aller
jusqu'a 1 million ! Cela dépend uniquement de
combien de calculs vous voulez faire ! Vous
pouvez jouer avec les autres parameétres vu
qu'ils demandent habituellement quelques
tests mais les réglages par défaut donneront
de bon résultats de toute maniere.

Pour aller plus loin avec les caustiques
Les caustiques ne sont pas restreints aux
seuls materiaux transparents! Vous pouvez
aussi utiliser les caustiques pour des
materiaux métalliques, rappelez-vous
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seulement que deux materiaux métalliques
refleteront aussi les photons donc vous ne les
verrez pas forcément quelques fois.

Pour finir ce tutoriel, je vais vous donner
quelques suggestions pour expérimenter :

Essayez d'ajouter une texture ou une couleur
au cube en lui donnant un peu de Nor ou de
Displacement.

Remplacez le cube par une sphére ou bien un
autre mesh. Utilisez plusieurs lampes de type
'Photon'. Péparez votre super machine pour
les rendus! Utilisez une texture globale de
type HDRI.

Envoyez-moi vos essais par mail | J'adorerais
jeter un oeuil dessus ! m

4 Daniel LaBarge

Je suis un infographiste et programmeur de
17 ans habitant a San Antonio, Texas.

Un artiste de studio indépendant chez ID
Studio [www.intellidesign.org]

et programmeur web chez MonsterWeb
www.monsterweb.net
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A ifie DPI, regardons
Les DPI demyStlfles comment il s'applique a Pixel Dimensions Image Resolution Printed size
Vous I'avez fait | Vous avez vraiment créé un ~ blender. Blender rend 640 x 480 72 dpi 8.89" x 6.67"
chef d'oeuvre. Mais quand vous l'avez imprimé, gssqll;?:gasb?egf%spallht 300 dpi 2.13" x 1.60"
il semblait tout pixellisé et anguleux. Bon, vous sur volre écran. mais 800 x 600 72 dpi 11.11" % 8.33"
deviez avoir un mauvais réglage quelque part. as & Im ressfon Pour 300 dpi 2.67" x 2.00"
Vous recommencez, vérifiez tous vos réglages, p mp - rou
cliquez sur render & nouveau et attendez. Le rendr? limage bonne 1024 x 768 72 dpi 14.22" x 10.67"
résultat est toujours le méme a l'impression. ggegé'gﬁfﬁfgg d\aous 300 dpi 3.41" x 2.56"
Vous commencez a proférer des menaces lus grand et le 1280 x 960 72 dpi 17.78" x 13.33"
silencieuses envers votre imprimante. Bon, f dirr? nsionner 4 | 300 dpi 4.27" x 3.20"
avant de vous décider a mettre ces menaces a beaissee a?/gc vgtri a _
exécution, vous voudriez peut étre essayer une roaramme d'édition 1600 x 1200 72 dpi 22.27" x 16.67
derniére chose (votre imprimante vous en sera grgghailque ?avgril E)n 300 dpi 5.33" x 4.00"
reconnaissante). gros ce que vous aurez 2400 x 1600 72 dpi 33.33" x 22.22"
. . . . a fai 'é i 300 dpi 8.00" x 5.33"
Vous devriez vous intéresser a la question des f‘ fa(ljri?ne?]t (Ij enchanger P
DPI. Bien que Blender possede des tailles de ehs i eesseot I: Blender (fig. 2)
rendu par défaut sympathiques, si vous ne physiqu . . . 9. 2)-
comprenez pas comment cela se traduit & résolution. Regardez le diagramme suivant (fig. . _
limpression, vous continuerez a maudire votre 1 ci-dessous) . [l montre quelques tailles de Une fois que vous avez rendu votre image en
imprimante ’ rendu communes et la taille correspondante a  utilisant cette technique, vous devez utiliser
' 72 dpi (qu'utilise Blender) et a une bonne votre programme d'édition graphique favori
Voyons d'abord ce que signifie DPI résolution d'impression de 300 dpi. Vous pour redimensionner votre image. Beaucoup
DPI est un terme d'impression qui défi.nit le pouvez voir que la taille physique diminue de ces programmes fonctionnent de la méme
quand vous augmentez la résolution. maniére, aussi adapter a votre programme ne

nombre de points/pixels compris a l'intérieur
d'un pouce carré et utilisés pour créer une
image (ndt : 1 pouce = 2,55 cm). Le terme plus

devrait pas étre difficile. J'utiliserai Photoshop
(Ga peut sembler trop compliqué, mais en fait pour expliquer cette partie, puisque je I'ai sous

correct est pixel par pouce, mais points par ca ne l'est pas. Il y a une formule trés simple la main.

pouce (Dot Per Inch) est souvent utilisé a la que vous pouvez . : .
place (limage peut étre une police ou un utiliser pour obtenir les Desired ( Desired (= Needed Pixel
l'image apparait bonne et nette. Le DPI est une {'jnéus}:‘ré)éezaralgetsaci)|luetlon

résolution d'impression. Le DPI n'est pas une hysi ug our obtenir 8 x 10 inches 150 1200 x 1500
résolution d'image, méme si il est fréquemment pnysique pol 8 x 10 inch 200 1600 x 2000
utilisé de cette maniére la taille en pixel dont N ci =

Ok, maintenant que nous savons ce questle  VOUS avez besoin dans 8 x 10 inches 300 2400 x 3000
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Etape 1: Ouvrez votre image

Etape 2: Allez dans Image>Image Size, une
boite de dialogue comme sur la fig. 3 devrait
s'ouvrir.

Etape 3: En bas de la boite, décochez
"Resample Image"

Etape 4: Dans le champ "Resolution”, entrez
votre nouvelle résolution. Les champs Height
et Width devraient automatiquement se mettre

I'attendiez.

Voila, vous avez maintenant une meilleure
idée de ce qu'est le dpi et de comment obtenir
le bon dpi pour imprimer, mais quelle est la
meilleure résolution dpi pour vous ? En
général, vous devriez choisir une résolution
entre 150 et 300 dpi. Cette résolution est
bonne pour la plupart des projets d'impession.
Si vous faites imprimer par un professionnel, il
est toujours bon de se renseigner pour savoir

a quelle résolution son équipement fonctionne.

ATELIER 2D - Les DPI démystifiés 29

a jour en fonction de la nouvelle résolution.

Etape 5: Appuyez sur le bouton OK et
sauvegardez, vous avez fini et maintenant
votre image devrait s'imprimer comme vous

Pixel Dimensions: 1.38M

width: [ pixets | :l@ Cancel
Rd

Height: ~ [600 | pixets

Sandra Gilbert

Salut, je m'appelle Sandra Gilbert, (aka dreamsgate). J'utilise
Auto. Blender depuis un peu plus de cing ans. Je vis actuellement a
Nampa, Idaho, USA et travaille comme designer graphique

Document Size: pour une petite imprimerie.
width:  [11.111 [ inches -| . . . . :
]g Je suis mariée et ai deux enfants, ce qui ne me laisse pas
Height: 8333 | inches =l trop de temps pour nourrir mon obsession grandissante pour
Besolution: |72 [pivets/inch =] Blender. Mais d urTe maniére ou d'une autre j essaye de
trouver le temps d'explorer les nouvelles fonctions, de me
e m—— tenir au coura.nt des dernieres nouyelles ?t de commencer de
nouveaux projets Blender. Je parviens méme vraiment a en
W Resample fmage: | Bicubic R finir certains
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LIGHTING &
RENDERING

Digital lighting &

rendering

JEREMY BIRN

Critique de livre
Digital Lighting and Rendering

Cette fois-ci nous examinons “[digital] Lighting
and Rendering” de Jeremy Birn.

Si vous ne l'aviez pas compris, cela ne tardera
pas, I'éclairage est une tres grande partie d'un
projet réussi. Vous pouvez avoir les meilleurs
modéles, matériaux et composition, mais sans
un éclairage convenable votre image tombera a
plat.

Entrez dans “[digital] Lighting and Rendering”.
Jeremy Birn vous guide pas a pas, avec des
exemples logiques et clairement expliqués, a
travers le probléme souvent complexe et
déroutant que pose I'éclairage. Il démarre avec
comment paramétrer un bon flux de lumiere et
explique alors chaque type de lumiére que vous
pouvez avoir.

Il continue avec des discussions approfondies
sur ce qu'est I'éclairage et comment la lumiére
et l'ombre se comporte dans le vrai monde,
progressant alors avec la théorie des couleurs,
la qualité de la lumiére, de I'ombre et de
I'exposition.

Aucun livre sur I'éclairage ne serait bon sans
une explication minutieuse sur le paramétrage
des lumiéres. Et celle-ci est une excellente
ressource pour apprendre les diverses lumiéres
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et leurs usages.

Puis il explique comment les matériaux
s'insérent dans le canal de rendu. Commencant
avec les ombres de surfaces, il continue avec
des explications détaillées sur comment
différents réglages de matériaux affectent
I'éclairage et le rendu. Dans ce méme chapitre,
il explique aussi les usages et les avantages du
raytracing et de l'illumination globale.

Le dernier chapitre couvre la composition et le
rendu dans les layers, montrant I'usage de
différent traitement de rendu pour obtenir juste
l'effet que vous cherchez.

Ce livre est définitivement un incontournable
pour les novices et pourtant méme un artiste de
CG expérimenté ne perdra rien a 'y jeter un
coup d'oeil. m

--blenderart
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Le haricot sauvage (The wild bean) [Yafray]
par - Claas Eicke Kuhnen
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Galerie - pg2

Composition [Yafray]
par - Claas Eicke Kuhnen

www.blenderart.org



Galerie - pg3

Pez [Yafray]
par - Claas Eicke Kuhnen
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Un temple (A temple) [Yafray]
par - Karan Sah

www.blenderart.org



Galerie - pg5 35

Trident (Trishul) [Yafray]
par - Karan Sah
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La fille surfant sur I'air (Airsurfboarding girl)
par - Zoltan Miklosi
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L'assasin (The Assasin) Nancy dans la rue (Nancy on the street)
par - Zoltan Miklosi par - Zoltan Miklosi
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Maluda le grand guerrier (Maluda The Great Warrior)
par - Zoltan Miklosi
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Automne (Autumn)
par - Jason Saundersi
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Abandoned Subway

Souterrain abandonné (Abandoned Subway)
par - Stephen Davis
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Pause café (Coffee Time)
par - Pawet Korzeniak
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Alien
par - Derek Marsh
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Patrick I'étoile de mer (Patrick star)
par - John Starr aka itraenk
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__ Posfoce N

Nous avons été
débordés par le flot
constant d'évaluations
et de commentaires
que nous avons recus
de la communauté
Blender.

Bonjour ! Chers Blenderiens.

Nous avons mis au-devant de la scéne pour
vous un bon nombre de connaissances durant
les 6 derniers mois. Dans chaque édition,
nous prenons un aspect particulier de la
Création Graphique en rapport avec Blender
et nous vous présentons un ensemble de
connaissances trés utiles. Tout ceci est géré
avec l'aide de Blenderiens experimentés qui
font partie de la communauté Blender. lls
aident a répandre la connaissance en
partageant le contenu de leur champ
d'expertise respectif.

Quand nous avons commencé a publier le
magazine, c'était notre but de fournir de
bonnes ressources pour couvrir les différents
aspect de la CG avec comme principal objectif
d'étre basé sur une approche facile et
compréhensible pour les nouveaux utilisateurs
de Blender. Nous avons été débordés par le
flot constant d'évaluations et de commentaires
que nous avons regus de la communauté
Blender. Ceci prouve que nous avons au
moins réussi dans ce domaine. Je saisi
l'occasion pour, au nom de notre petite équipe
ici a blenderart, tous vous remercier de vos
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commentaires et suggestions et, a certains
moments, de votre patience. Et bien entendu,
un grand merci a tous ceux qui nous ont fourni
ce précieux et nécéssaire contenu pour ce
magazine.

Cette fois ci, notre site web a été hébergé
grace a ibiblio.org qui nous a gracieusement
fourni I'espace web. Nam Pham a vraiment
fait du trés bon travail pour le nouveau design
du site ainsi que pour l'inscription tant désirée
a notre mailing list. Maintenant, tous ceux qui
s'inscriront sur cette liste recevrons une note
aussi tét que la nouvelle édition sortira.

Avec cette édition sortie, nous commengons
également a restructurer le design du
magazine ainsi que le contenu afin de
continuer a vous fournir toujours une meilleure
experience d'apprentissage pour les temps a
venir.

Donc jusqu'a présent continuez a nous
envoyer vos précieux commentaires et
remarques.

Joyeux blending !
Gaurav
gaurav@blenderart.org



ISSUE 4
Disponible en Mai 2006
Théme: La Modélisation de Personnages.

Techniques de modélisation.
Trucs et astuces.

DISCLAIMER
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